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Troubleshooting Federal 
Child Count Reports

The Ohio Department of Education funds development of EMIS training materials 
as part of the EMIS Alliance grant. There is an expectation that ITCs will utilize these 
materials in training provided to your districts. That said, there are restrictions on 
use of the EMIS Alliance materials as follows: Materials developed as part of the 
EMIS Alliance program must be provided at no cost to your training participants. If 
you utilize the EMIS Alliance training materials – in whole or in part – you must not
charge participants a fee to attend the class where the materials are used. Likewise, 
you may not use the materials or any portion thereof in any event where a fee is 
charged to attend. Exceptions must be approved in writing by the Department of 
Education in advance of scheduling/promoting any event which may violate these 
restrictions.

Questions regarding appropriate use of EMIS Alliance materials, or requests for 
exception to the restrictions noted above, should be directed to Melissa Hennon 
[Melissa.Hennon@education.ohio.gov].
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Overview

• The Federal Child Count (FCC) 
• Includes students with disabilities who are receiving special education 

services according to their IEPs as of October 31

• Is used in determining the amount of Special Education Part-B IDEA 
and Early Childhood Special Education funds allocated to the state

• Is collected from all LEAs except for ESCs and JVSDs through the 
Education Management Information System (EMIS) and is submitted 
to the US Department of Education (USDOE)

• This presentation will focus on troubleshooting the EMIS FCC 
Reports, which are generated throughout the EMIS data 
submission process
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EMIS Data Collections and the FCC Snapshot

• Collections containing the FCC report
• Beginning of Year Student (S) Collection

• SOES Beginning of Year Student (S) Collection

• Collections are scheduled to close December 21, 2020
• FCC will close when the above collections close

• There is no appeal for the FCC
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FCC Reports

• Level 2 Reports
• (FCCD-001) Federal Child Count Detail

• (FCCS-001) Federal Child Count Statement of Assurances

• FCC Reports are updated nightly

• Can contain data reported by other LEAs

• Review the most recent version of the reports throughout 
the data collection process

• Submit updated EMIS data to make corrections to the 
reports
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Level 2 Reports 
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Select the Level 2 Reports link

5

6



12/7/2020

4

FCC Reports 

7

Select “Show Reports”

FCC was added to the 
filter in this example 

Formatting the FCC Detail Report

• Open the (FCCD-001) Federal Child Count Detail Report
• Wrap text header row

• Freeze top row

• Expand all columns

• Apply filters
• Better yet, run your macro!
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Quick Check • Are you using the most recent 
version of the report?

• Are you able to open and format 
the CSV report to begin the review 
process?

• Can you apply filters to all 
columns? 

The Federal Child Count Detail 
Report contains student detail 
data as it pertains to the 
count. This report is critical in 
the data review and error 
correction process and should 
be carefully reviewed for 
accuracy and completeness.
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Troubleshooting 
the Federal Child Count 

Detail Report
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Troubleshooting the FCC Detail Report

The next series of slides will review data contained in the 
report including

• Severity Codes and Numbers

• Federal Child Count Flag

• Who is and is not included in my FCC?

• FCC Report Data
• Status Codes and corrective actions

11

Severity Numbers and Codes
Severity Numbers (ERR SEV NUM) are aligned with Severity Codes

• Report is sorted least severe to most severe

• Severity Code will be noted for each Status Code

• Review all students regardless of Severity Code
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I – Informational - 15
W – Warning - 39
C – Critical - 63 
F – Fatal - 79
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Federal Child Count Flag 

FED CCT FLAG 
• Y – Student is intended to be included in the Federal Child Count

• N – Student not included in the Federal Child Count

• Review all students on the report regardless of flag
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Who is included in my FCC?
• In most cases, students count at their resident district except for 

students attending -
• Community Schools

• STEM Districts

• Ohio School for the Blind

• Ohio School for the Deaf
• Buckeye United (DYS)

• Pilot Programs 

• Non-Public students receiving related services count at the traditional 
district providing the related services if active IEP event is reported as of 
October 31
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Who is not included in my FCC? 

• Students with a disability as of October 31, who are not 
being reported with an active IEP event as of October 31

• Students reported with the following IEP outcomes
• IEPR – IEP Complete – Parental Refusal

• IENS – IEP Complete – Not Served
• IEDP – IEP Resulted in Due Process

• Refer to the FCC Level 2 Report Explanation, section “Include 
in USDOE Count” for additional information and exceptions
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FCC Report Data 
• Disability Condition Code

• Student must be reported to EMIS with a disability as of October 
31 to be included on the report 

• Review for accuracy

• Student Age Number
• Student’s age as of October 31
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FCC Report Data, cont’d
• Legal District of Residence

• FED CCT ALT IRN
• Populated for Status Code FC0006 with LEA IRN where the student will count

• Sent Reasons and IRNs
• Displays if relevant to the FCC
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FCC Report Data, cont’d
• FED CCT LRE Code – Least Restrictive Environment Code 

• If this is blank, the student is not included in the count 

• Value comes from IEP, FN270, or is derived

• DIST LRE SRC CODE and DIST LRE SRC DESCR 
• Source codes indicate what data the report is looking at

• Use in combination with the Status Code value to determine what is being 
reported for each student
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LRE Source Codes, cont’d

• 1 - No Disability on October 31 *New*

• 3 - Student’s age is not 3 – 21 

• 5 - No IEP Reported 

• 7 - FN270 Override

• 8 - GE Record

19

LRE Source Codes, cont’d
• 9 - How Received = 6 

• FED CCT LRE CODE will be IE39 Ages 5 and up, Not Grade Level PS

• FED CCT LRE CODE will be IE39 Ages 6 and up, Grade Level PS

• C - How Received = 6 and Grade Level  = PS *New*
• FED CCT LRE CODE will be IE51 if Ages 3 to 5 and Grade Level PS

• A - Sent Reason = AU or JP 
• FED CCT LRE CODE will be IE39 if age 6 or older and IE51 if age 3-5

• B - Changed to DYS LRE (Appears only on DYS report) *New*

•
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Quick Check • Are all students appearing on the 
report as expected?

• Has someone verified the data for 
accuracy?

• Has updated EMIS data been 
submitted to correct any 
inaccuracies on the report? 

The Federal Child Count Detail 
Report contains data specific 
to students with disabilities. 
Understanding each column 
of data is important to begin 
analyzing the data for 
accuracy and completeness. 
There is not an error for 
everything, so time spent 
reviewing all data on the 
report is recommended.  

21

FED CCT Status Codes

FED CCT STATUS CODE and FED CCT STATUS CODE DESCR
• Indicates the status of a student as it relates to inclusion in the count

• Indicates that a data issue exists or that no errors are identified 

• Data with no errors on the report should still be reviewed for accuracy 
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FED CCT Status Code FC0001

Filter on FC0001 
• On Oct 31 Student age is outside the 3-21 included range (Fatal)

• Source Code 3 - Student age is not 3 – 21 

• FED CCT FLAG - N

• View the student’s reported date of birth on the Student 
Demographic (GI) Record to confirm age

• If the student’s date of birth is incorrect, make the correction and 
submit updated EMIS data
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FED CCT Status Code FC0002

Filter on FC0002 
• Unable to translate LRE-must report FN270 element (Critical)

• Source Code 7 - FN270 Override
• or Source Code 8 - GE Record
• FED CCT Flag - N

• As of October 31 the student’s IEP Outcome (LRE) must agree with 
the student’s age and grade level
• For ages 3-5 and in preschool, the LRE should be in the IE51 to IE72 

range, if not report an LRE within this range on the FN270 
• For ages 5 and over and in kindergarten or higher, LRE should be in 

the IE13 to IE39 range, if not report an LRE within this range on the 
FN270 
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Age, Grade Level, and Expected LRE

• Age 3 to 5, Preschool Grade Level - Count as Preschool Student 
• Preschool LRE Expected (IE51-IE72)

• Age 4, Kindergarten Grade Level - Count as Preschool Student
• Preschool LRE Expected (IE51-IE72)

• Age 5 and up, Kindergarten Grade Level - Count as School Aged 
Student 
• School Aged LRE Expected (IE13-IE39)

• Age 6 and up, Any Grade Level, including Preschool - Count as 
School Aged Student
• School Aged LRE Expected (IE13-IE39)

25

Reporting the FN270 Element
Updated October 31 IEP Outcome Element (FN270)

• The current IEP outcome and FN270 values should not be the same
• When the FN270 value is reported correctly the LRE that aligns with 

the student’s age and grade level will appear in the column FED CCT 
LRE CODE

• When reported incorrectly the FED CCT LRE CODE column will be 
blank

26

Incorrect 

Correct
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FED CCT Status Code FC0003

Filter on FC0003 
• CIEP most recent IEP - should be no disability (Warning)

• Source Code 8 - GE Record

• FED CCT FLAG - N

• Verify the CIEP event and confirm that the student’s disability code 
is being reported as ending on the date of the CIEP event

• If the student’s disability code on the Student Attributes - Effective 
Date (FD) Record is not reported as ended, make the correction 
and submit updated EMIS data
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FED CCT Status Code FC0004

Filter on FC0004 
• No IEP reported for Oct 31 date (Fatal) 

• Source Code 5 - No IEP Reported

• FED CCT Flag – N *NEW*

• FED CCT LRE CODE – Blank *NEW*

• Verify the student’s special education event records as of October 31

• Verify the most recent IEP was reported to EMIS

• Report an NIEP if appropriate
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ODDEX Records
Special Education Data Tab 

• Use to verify if the student’s IEP events were reported to EMIS

29

NIEP Date Type - No IEP

• NIEP events using the non-compliance reasons 10 or 11 
should be reported no longer than 30 days 
• 10 - Student newly transferred in; IEP adoption determination not 

complete; services being provided based on prior IEP

• 11 - IEP expired; new IEP not in place; services being provided 
based on prior IEP

• NIEP events using the non-compliance reason of 12 can be 
used until the end of the IEP that did not get reported to 
EMIS 
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FED CCT Status Code FC0005

Filter on FC0005
• Student does not meet inclusion filter in this district (Warning)

• Source Code 5 - No IEP Reported 
• or Source Code 7 - FN270 Override
• or Source Code 8 - GE Record
• FED CCT Flag – N

• Shared students can have this Status Code at the educating district
• Shared students where IEPs are not reported can also have this 

Status Code with Source Code 5 – No IEP Reported
• Refer to the Federal Child Count Report Explanation, section “Include 

in USDOE Count” 

31

FED CCT Status Code FC0005, cont’d 

Filter on FC0005
• Student does not meet inclusion filter in this district (Warning)

• Source Code 9 – How Received = 6 
• FED CCT Flag – N

• Non-Public special education students receiving related services 
from reporting district with No IEP reported on October 31
• Report does not consider ISPs 
• If no IEP in place on October 31, then the student is not included in the FCC
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Multiple District Tie Breakers

1.  Will count at Buckeye United if reported by Buckeye United (060988)

2.  Will count where Reporting IRN = District of Residence IRN
~OR~ counts where Reporting IRN is reporting a How Received code of    
M (Community School) or K (STEM District)

3. If multiple entities are claiming the student in the same way (as #2  
above), then the student is included at the entity with the later 
admission date

4. If entities are claiming the student in the same way (as #2 above) and
reporting the student with the same admission date, then the student
will not count for any district 
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FED CCT Status Code FC0006
Filter on FC0006 

• Student counting in alternative district - does not count in your 
district (Warning)
• Source Code 5 – No IEP Reported - verify if special education events need to 

be reported for this student
• or Source Code 7 - FN270 Override 
• or Source Code 8 - GE Record
• or Source Code 9 - How Received = 6
• or Source Code A - Sent Reason AU or JP
• FED CCT Flag - N

• Student counts at the IRN in the FED CCT ALT IRN column
• Review data in ODDEX to compare how data is being reported
• Communicate with the alternative district to determine how this 

student should be reported
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FED CCT Status Code FC0007

Filter on FC0007
• Student excluded -conflict in where student should count (Fatal) 

• Source Code – 7 FN270 Override
• Or Source Code – 8 GE Record
• FED CCT Flag - N

• Could not determine where this student should count, so the student 
will not be counted at either entity

• Review data in ODDEX to compare how data is being reported by both 
entities

• Communicate with the other entity to determine how this student 
should be reported
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FED CCT Status Code FC0008
Filter on FC0008

• No errors identified in ODE processing (Informational) 
• Source Code 7 – FN270 Override 
• or Source Code 8 – GE Record
• or Source Code 9 – How Received = 6
• or Source Code A – Sent Reason = AU or JP
• or Source Code B – Changed to DYS LRE (appears on Buckeye United FCC Report) 
• or Source Code C – How Received = 6 and Grade = PS 
• FED CCT Flag – Y 

• Data for the students should be reviewed for accuracy
• Apply filters to verify elements such as disability conditions and LREs
• District staff can be very helpful in verifying data accuracy and 

completeness
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Quick Check
• Have all status codes been 

reviewed, and all reporting issues 
corrected? 

• When corrections have been 
made in the student information 
system (SIS), has that updated 
data been submitted to EMIS?

• Based on inclusion criteria are all 
of your special education students 
being counted correctly?

The Federal Child Count Detail 
report will display students 
who are and who are not 
included in your count. The 
report will also indicate 
students with issues 
preventing them from being 
included. Check this report 
often as it can be effected by 
another entity’s EMIS 
reporting. 
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Troubleshooting 
the Federal Child Count Statement of 

Assurances Report
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Open the FCC Statement of Assurances Report 

39

Format the report 
by wrapping the 
text in the header 
row and expanding 
all columns 

Understanding Statement of Assurances 

• The report includes
• only students who have a FED CCT Flag = Y
• all students age 3 to 5 in the first category
• students age 6 to 21 in each disability specific category

• Using the above criteria the next series of slides will match 
the FCC Detail Report against the FCC Statement of 
Assurances Report 

• When you are told that the counts on this report are 
incorrect, filtering allows you to show which students are 
included or not included
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Filter on FCC CCT Flag 

41

Select Y on the 
FED CCT Flag Filter on 
the FCC Detail Report 

These are the students 
who are included in 
the Statement of
Assurances Report

Add Second Filter on Student Age Number 

42

Select ages 3, 4 and 
5 on the Student Age 
Number Filter

These students are included in the 3, 
4, and, 5-year olds with any disability 
on the Statement of Assurances report 
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Matching Data Between Reports

43

2. This will match the count on the Statement of Assurances. 

1. From the filtered students on the FCC Detail Report, select 
a range of cells and see the “count” appear at the bottom 
of the spreadsheet.

Arrange All 

44

With two spreadsheets 
open at the same time, 
from the View tab select 
“Arrange All” and then 
“Vertical” and “OK”
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Arrange All cont’d

45

“Arrange All” allows 
both spreadsheets to 
be viewable at the 
same time

Change the Student Age Filter

46

Change the filter for the Student 
Age Number column to include 
all ages except 3, 4, and 5

Leave the FED CCT Flag 
Column filter set to 
show only Y values 
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Add a Third Filter

47

Add a third filter in 
the DISAB CNDTN 
CODE column

Select one disability 
code at a time

Match the Data Between the Reports 

48

1. From the filtered students on the 
FCC Detail Report, select a range 
of cells and see the “count” appear 
at the bottom of the spreadsheet. 

2. This will match the count on 
the Statement of Assurances. 

47

48



12/7/2020

25

Quick Check • Can you match the data between 
the two reports using filters?

• Are you seeing the numbers of 
students that you were expecting? 

• Has this data been shared with 
others in your district?

The Federal Child Count
Statement of Assurances 
Report is derived from the 
same data that is on the FCC 
Detail Report. Using filters, 
you can match the data 
between the reports. The 
Statement of Assurances is 
sometimes requested by 
auditors.
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Summary

• The FCC Reports contain both data to verify and issues to 
correct

• Some issues can be corrected, and some are simply stating 
the fact that the student cannot be included in the count 

• Work with district staff to verify that the data is both correct 
and complete

• “No errors” does not necessarily mean that your data is 
accurate
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Resources

• Federal Child Count Detail Report and Federal Child Count 
Statement of Assurances Report Explanation
• ODE Home > Data > EMIS > Documentation > EMIS Validation and 

Report Explanations 

• EMIS Manual 
• ODE Home > Data > EMIS > Documentation > EMIS Manual

• Your district staff

• Your ITC
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Questions?
Please complete a feedback form to receive your attendance certificate 

https://tinyurl.com/EA-District-Feedback
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